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Bugs et tests

• Fiabilité des logiciels : 
• Probabilité qu'un système logiciel ne provoque pas de défaillance dans des conditions spécifiées.

• Mesurée par le temps de fonctionnement, le MTTF (mean time till failure), les données de crash.

• Les bugs sont inévitables dans tout système logiciel complexe.
• Estimations de l'industrie : 10 à 50 bugs pour 1000 lignes de code.

• Un bug peut être visible ou se cacher dans votre code jusqu'à une date ultérieure.

• Tests unitaires : Une tentative systématique de révèler les erreurs.
• Test échoué : une erreur a été démontrée.

• Test réussi : aucune erreur n'a été trouvée (pour cette situation particulière).
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Difficulté de tester

• Perception de certains développeurs et managers :

• Les tests sont considérés comme un travail de novice.

• Il est confié aux membres les moins expérimentés de l'équipe.

• Effectués après coup (voir jamais).

• "Mon code est bon, il n'y a pas de bugs, je n'ai pas besoin de le tester.  Je n'ai pas besoin de le 
tester".

• "Je trouverai les bugs en exécutant le programme client".

• Limites de ce que les tests peuvent vous montrer :

• Il est impossible de tester complètement un système.

• Les tests ne révèlent pas toujours directement les bugs réels dans le code.

• Les tests ne prouvent pas l'absence d'erreurs dans les logiciels.
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Unit testing

• Les tests unitaires : Recherche d'erreurs dans un sous-système isolé.

• En général, un "sous-système" désigne une classe ou un objet particulier.

• La bibliothèque Java JUnit nous aide à effectuer facilement des tests unitaires.

• L'idée de base :

• Pour une classe donnée Foo, créez une autre classe FooTest pour la tester, contenant diverses
méthodes de "cas de test" à exécuter.

• Chaque méthode recherche des résultats particuliers et réussit ou échoue.

• JUnit fournit des commandes "assert" pour nous aider à écrire des tests.

• L'idée : Placez des appels d'assertion dans vos méthodes de test pour vérifier les choses que vous
vous attendez à voir vraies.  Si ce n'est pas le cas, le test échouera.
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JUnit / Eclipse

• Pour ajouter JUnit à un projet Eclipse, 
cliquez sur :
• Project → Properties → Build Path → Libraries 
→ Add Library... → JUnit→ JUnit 4→ Finish

• Pour créer un cas de test :
• cliquez avec le bouton droit de la souris sur un 

fichier et choisissez : New → Test Case

• Ou en general : File → New →
JUnit Test Case

• Eclipse peut créer des squelettes de tests 
pour vous.
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Classe de test (a exécuter en tant que test)

import org.junit.*; 

import static org.junit.Assert.*;

public class name {

...

@Test

public void name() {  // a test case method

...

}

}

• Une méthode tagguée @Test sera considérée comme un “JUnit test case”.
• Toutes les @Test méthodes seront exécutées quand Junit teste la classe.
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JUnit assertion methods

• Chaque méthode peut également recevoir une chaîne de caractères à afficher en cas
d'échec :

• par exemple, assertEquals("message", expected, actual)

assertTrue(test) fails if the boolean test is false

assertFalse(test) fails if the boolean test is true

assertEquals(expected, actual) fails if the values are not equal

assertSame(expected, actual) fails if the values are not the same (by ==)

assertNotSame(expected, actual) fails if the values are the same (by ==)

assertNull(value) fails if the given value is not null

assertNotNull(value) fails if the given value is null

fail() causes current test to immediately fail
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ArrayIntList JUnit test

import org.junit.*; 

import static org.junit.Assert.*;

public class TestArrayIntList {

@Test

public void testAddGet1() {

ArrayIntList list = new ArrayIntList();

list.add(42);

list.add(-3);

list.add(15);

assertEquals(42, list.get(0));

assertEquals(-3, list.get(1));

assertEquals(15, list.get(2));

}

@Test

public void testIsEmpty() {

ArrayIntList list = new ArrayIntList();

assertTrue(list.isEmpty());

list.add(123);

assertFalse(list.isEmpty());

list.remove(0);

assertTrue(list.isEmpty());

}

...



9
Exécuter les tests

• Cliquez avec le bouton droit de la souris sur le paquet dans l'explorateur de paquets
d'Eclipse à gauche ; choisissez :
• Run As → JUnit Test

• La barre JUnit s'affiche en vert si
tous les tests passent, en rouge s'ils échouent.

• La trace d'échec indique quels tests 
ont échoué, le cas échéant, et pourquoi.
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JUnit exemple

• On suppose une classe Date avec les méthodes suivantes :
• public Date(int year, int month, int day)

• public Date()                   // today

• public int getDay(), getMonth(), getYear()

• public void addDays(int days)   // advances by days

• public int daysInMonth()

• public String dayOfWeek()       // e.g. "Sunday"

• public boolean equals(Object o)

• public boolean isLeapYear()

• public void nextDay()           // advances by 1 day

• public String toString()
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Ce qui ne va pas !

public class DateTest {

@Test

public void test1() {

Date d = new Date(2050, 2, 15);

d.addDays(4);

assertEquals(d.getYear(), 2050); // il faut inverser

assertEquals(d.getMonth(), 2);

assertEquals(d.getDay(), 19);

}

@Test

public void test2() {

Date d = new Date(2050, 2, 15);

d.addDays(14);

assertEquals(d.getYear(), 2050);

assertEquals(d.getMonth(), 3);

assertEquals(d.getDay(), 1);

}

}



12
Assertions bien structurées

public class DateTest {

@Test

public void test1() {

Date d = new Date(2050, 2, 15);

d.addDays(4);

assertEquals(2050, d.getYear());  // expected

assertEquals(2, d.getMonth());    // value should 

assertEquals(19, d.getDay());     // be at LEFT

}

@Test

public void test2() {

Date d = new Date(2050, 2, 15);

d.addDays(14);

assertEquals("year after +14 days", 2050, d.getYear());

assertEquals("month after +14 days", 3, d.getMonth());

assertEquals("day after +14 days", 1, d.getDay());

}   // test cases should usually have messages explaining

}       // what is being checked, for better failure output
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Utilisation d’objet attendue

public class DateTest {

@Test

public void test1() {

Date d = new Date(2050, 2, 15);

d.addDays(4);

Date expected = new Date(2050, 2, 19);

assertEquals(expected, d);  // use an expected answer

}                               // object to minimize tests

// (Date must have toString

@Test                           //  and equals methods)

public void test2() {

Date d = new Date(2050, 2, 15);

d.addDays(14);

Date expected = new Date(2050, 3, 1);

assertEquals("date after +14 days", expected, d);

}

}
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Nommage des test cases

public class DateTest {

@Test

public void test_addDays_withinSameMonth_1() {

Date actual = new Date(2050, 2, 15);

actual.addDays(4);

Date expected = new Date(2050, 2, 19);

assertEquals("date after +4 days", expected, actual);

}

// give test case methods really long descriptive names

@Test

public void test_addDays_wrapToNextMonth_2() {

Date actual = new Date(2050, 2, 15);

actual.addDays(14);

Date expected = new Date(2050, 3, 1);

assertEquals("date after +14 days", expected, actual);

}

// give descriptive names to expected/actual values

}
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Ce qui ne va pas !

public class DateTest {

@Test

public void test_addDays_addJustOneDay_1() {

Date actual = new Date(2050, 2, 15);

actual.addDays(1);

Date expected = new Date(2050, 2, 16);

assertEquals(

"should have gotten " + expected + "\n" +

" but instead got " + actual\n", 

expected, actual);

}

...

}
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Les messages des assertions

public class DateTest {

@Test

public void test_addDays_addJustOneDay_1() {

Date actual = new Date(2050, 2, 15);

actual.addDays(1);

Date expected = new Date(2050, 2, 16);

assertEquals("adding one day to 2050/2/15", 

expected, actual);

}

...

}

// JUnit affichera déjà

// les valeurs attendues et réelles

// dans sa sortie ;

//

// Il n'est pas nécessaire de les répéter

// dans le message de l'assertion
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Tests avec Timeout

@Test(timeout = 5000)

public void name() { ... }

// La méthode ci-dessus sera considérée comme un échec si

// elle ne s'exécute pas dans les 5000 ms.

private static final int TIMEOUT = 2000;

...

@Test(timeout = TIMEOUT)

public void name() { ... }

// Times out / fails after 2000 ms
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Pervasive timeouts

public class DateTest {

@Test(timeout = DEFAULT_TIMEOUT)

public void test_addDays_withinSameMonth_1() {

Date d = new Date(2050, 2, 15);

d.addDays(4);

Date expected = new Date(2050, 2, 19);

assertEquals("date after +4 days", expected, d);

}

@Test(timeout = DEFAULT_TIMEOUT)

public void test_addDays_wrapToNextMonth_2() {

Date d = new Date(2050, 2, 15);

d.addDays(14);

Date expected = new Date(2050, 3, 1);

assertEquals("date after +14 days", expected, d);

}

// presque tous les tests devraient avoir un timeout afin de ne pas 

// conduire à une boucle infinie. Il est bon de fixer une valeur par défaut, aussi

private static final int DEFAULT_TIMEOUT = 2000;

}
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Tester les exceptions

@Test(expected = ExceptionType.class)

public void name() {

...

}

// Le test est réussi s'il déclenche l'exception donnée.

// Si l'exception n'est pas levée, le test échoue.

// Utilisez cette fonction pour tester les erreurs attendues.

@Test(expected = ArrayIndexOutOfBoundsException.class)

public void testBadIndex() {

ArrayIntList list = new ArrayIntList();

list.get(4);   // should fail

}
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Cycle de vie d’exécution

@Before

public void name() { ... }

@After

public void name() { ... }

// méthodes à exécuter avant/après l'appel de chaque méthode de test

// dans JUnit 5 la syntaxe a changé : beforeEach / afterEach

@BeforeClass

public static void name() { ... }

@AfterClass

public static void name() { ... }

// méthodes à exécuter une fois avant/après l'exécution de l'ensemble de la classe de test

// dans JUnit 5 la syntaxe a changé : beforeAll / afterAll
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Quoi tester ?

• Vous ne pouvez pas tester toutes les entrées possibles, toutes les valeurs de 
paramètres, etc.
• Vous devez donc penser à un ensemble limité de tests susceptibles de révéler des bugs.

• Pensez aux cas limites
• les nombres positifs, nuls et négatifs
• juste à la limite de la taille d'un tableau ou d'une collection

• Pensez aux cas vides et aux cas d'erreurs
• 0, -1, null ; une liste ou un tableau vide

• tester le comportement en combinaison
• peut-être que add fonctionne habituellement, mais échoue après avoir appelé remove
• faire plusieurs appels ; peut-être que la taille échoue la deuxième fois seulement
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Ce qui ne va pas !

public class DateTest {

// test every day of the year

@Test(timeout = 10000)

public void tortureTest() {

Date date = new Date(2050, 1, 1);

int month = 1;

int day = 1;

for (int i = 1; i < 365; i++) {

date.addDays(1);

if (day < DAYS_PER_MONTH[month]) {day++;}

else                             {month++; day=1;}

assertEquals(new Date(2050, month, day), date);

}

}

private static final int[] DAYS_PER_MONTH = {

0, 31, 28, 31, 30, 31, 30, 31, 31, 30, 31, 30, 31

}; // Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec

}
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Tests à logique complexe

• Testez une chose à la fois par méthode de test.
• 10 petits tests valent bien mieux qu'un test 10 fois plus important.

• Chaque méthode de test doit comporter peu d'affirmations (probablement 1).
• Si vous faites plusieurs assertions, la première qui échoue arrête le test.

• Vous ne saurez pas si une assertion ultérieure aurait échoué.

• Les tests doivent éviter la logique.
• minimiser les if/else, les boucles, les switchs, etc.

• éviter les try/catch

• S'il est supposé être lancé, utilisez expected= ... sinon, laissez JUnit l'attraper.

• Les “Torture Tests” sont acceptables, mais seulement en complément de tests simples.
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Éliminer la redondance

public class DateTest {

@Test(timeout = DEFAULT_TIMEOUT)

public void addDays_withinSameMonth_1() {

addHelper(2050, 2, 15, +4, 2050, 2, 19);

}

@Test(timeout = DEFAULT_TIMEOUT)

public void addDays_wrapToNextMonth_2() {

addHelper(2050, 2, 15, +14, 2050, 3, 1);

}

// utiliser beaucoup d'aides pour rendre les tests extrêmement courts

private void addHelper(int y1, int m1, int d1, int add,

int y2, int m2, int d2) {

Date act = new Date(y, m, d);

actual.addDays(add);

Date exp = new Date(y2, m2, d2);

assertEquals("after +" + add + " days", exp, act);

}

// peut également utiliser des "tests paramétrés" dans certains frameworks

...
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Tests avec conditions

• Tests exécutés selon les OS ou les Version Java
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Tests avec conditions

• Conditionner selon des paramètres système ou des variables d’environnement
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Tests répétés

• Exécution répétée des tests

• Possibilité d’afficher les informations de chaque itération
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Nested Tests

• Il est possible d’organiser les tests hiérarchiquement
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Assumptions

• Possible d’ajouter des Assumptions

• Le test est arrêté en cas d’assumption non valide
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Tests paramétrés

• Effectuer des tests avec des arguments externes

• Source peut être une Value Source

• Primitive types + java.lang.String + java.lang.Class (instances de la classe Class)
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Tests paramétrés

• Effectuer des tests avec des arguments externes

• Source peut être une méthode génératrice
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Tests paramétrés

• Effectuer des tests avec des arguments externes

• Source peut être des données en csv
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Tests paramétrés

• Effectuer des tests avec des arguments externes

• Source peut être un fichier csv
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Regression testing

• Régression : Lorsqu'une fonctionnalité qui fonctionnait auparavant ne fonctionne plus.
• Cette situation est susceptible de se produire lorsque le code évolue et se développe au fil du 

temps.

• Une nouvelle fonctionnalité/un nouveau correctif peut provoquer un nouveau bug ou réintroduire
un ancien bug.

• test de régression : Ré-exécution de tests unitaires antérieurs après un changement.
• Souvent effectué par des scripts lors de tests automatisés.

• Utilisé pour s'assurer que les anciens bugs corrigés sont toujours corrigés.

• Donne à votre application un niveau minimum de fonctionnalité.

• De nombreux produits disposent d'un ensemble de tests de vérification obligatoires qui 
doivent être réussis avant que le code puisse être ajouté à un dépôt de code source.
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Test-driven development

• Les tests unitaires peuvent être rédigés après, pendant ou même avant le codage.

• Développement piloté par les tests : Écrire des tests, puis écrire du code pour les réussir.

• Imaginons que nous souhaitions ajouter une méthode subtractWeeks à notre classe
Date, qui décale cette date dans le temps d'un nombre donné de semaines.

• Écrivez du code pour tester cette méthode avant qu'elle ne soit écrite.

• Une fois la méthode implémentée, nous saurons si elle fonctionne.



36
Tests et structures de données

• Besoin de tester beaucoup de tableaux ?  Utiliser des Array literals

public void exampleMethod(int[] values) { ... }

...

exampleMethod(new int[] {1, 2, 3, 4});

exampleMethod(new int[] {5, 6, 7});

• Besoin d’une ArrayList?  Utiliser Arrays.asList

List<Integer> list = Arrays.asList(7, 4, -2, 3, 9, 18);

• Besoin de Set, Queue, etc.?  Utiliser les collections à partir d’une liste :

Set<Integer> list = new HashSet<Integer>(

Arrays.asList(7, 4, -2, 9));
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Ce qui ne va pas !

public class DateTest {

// shared Date object to test with (saves memory!!1)

private static Date DATE;

@Test(timeout = DEFAULT_TIMEOUT)

public void addDays_sameMonth() {

DATE = new Date(2050, 2, 15);      // first test;

addhelper(DATE,  +4, 2050, 2, 19); // DATE = 2/15 here

}

@Test(timeout = DEFAULT_TIMEOUT)

public void addDays_nextMonthWrap() {  // second test; 

addhelper(DATE, +10, 2050, 3, 1);  // DATE = 2/19 here

}

@Test(timeout = DEFAULT_TIMEOUT)

public void addDays_multipleCalls() {  // third test; 

addDays_sameMonth();               // go back to 2/19; 

addhelper(DATE, +1, 2050, 2, 20);  // test two calls

addhelper(DATE, +1, 2050, 2, 21);

}

...

}



38
Test case "smells"

• Les tests doivent être autonomes
et ne pas se soucier les uns des autres.

• Les "odeurs" (mauvaises choses à éviter) dans les tests :

• Ordre de test contraint : 
Le test A doit être exécuté avant le test B. 
(généralement une tentative malavisée de tester le flux).

• Les tests s'appellent les uns les autres : le test A appelle la méthode du test B 
(l'appel d'une aide partagée est acceptable).

• État partagé mutable : Les tests A/B utilisent tous deux un objet partagé.  
(Si A le casse, qu'arrive-t-il à B ?)
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Test suites

• test suite: One class that runs many JUnit tests.
• An easy way to run all of your app's tests at once.

import org.junit.runner.*;

import org.junit.runners.*;

@RunWith(Suite.class)

@Suite.SuiteClasses({

TestCaseName.class,

TestCaseName.class,

...

TestCaseName.class,

})

public class name {}

• La syntaxe a changé dans JUnit 5 : @Suite
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Exemple de Test suite

import org.junit.runner.*;

import org.junit.runners.*;

@RunWith(Suite.class)

@Suite.SuiteClasses({

WeekdayTest.class,

TimeTest.class,

CourseTest.class,

ScheduleTest.class,

CourseComparatorsTest.class

})

public class HW2Tests {}
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